Remote Annex

Quick Start for Windows

Read before installing and using Remote Annex
Software Release 4.2

These installation notes contain information specific to this release. This information is not available elsewhere in the Remote Annex documentation.
## Contents

Before Installing the Software .......................................................... 2  
Prerequisites ......................................................................................... 2  
Windows NT Log On Privileges .......................................................... 2  
Software Installation ........................................................................... 3  
   Server Software .................................................................................. 3  
   Workstation Software .......................................................................... 4  
Hardware Setup ..................................................................................... 5  
Network Address ................................................................................... 6  
Booting the Remote Annex ................................................................. 7  
Configuring the Remote Annex ............................................................ 8  
   Using Quick2Config Annex ............................................................ 8  
   Using the na Utility ............................................................................. 9  
   Configuring Security .......................................................................... 11  
Configuring the Remote Annex 6300 .................................................... 11  
   Initial Setup with na ......................................................................... 11  
   Setting Up PRI Channels ................................................................... 12  
   Configuring Security ........................................................................ 14
Remote Annex Quick Start for Windows


The procedures in this guide cover:

- Installing the software on the Windows NT server
- Setting up the Remote Annex
- Defining various network addresses
- Booting the Remote Annex
- Configuring the Remote Annex with Quick2Config and the na utilities

Before Installing the Software

Prerequisites

To install Remote Annex Server Tools for Windows NT, you need:

- Microsoft Windows NT Server 3.51 or 4.0 configured to support the TCP/IP protocol
- Administrative privileges on the server
- 10MB free disk space on an NTFS drive
- One Windows NT Client 3.51 or 4.0 license per Remote Annex
- PC with an Intel 486 (or higher) CPU with 32 MB RAM
- CD-ROM drive to install the product
- Several formatted floppy disks for PCs without CD-ROMs

Before you install the tools, you should close all other Windows programs.

The CD-ROM includes the appropriate Remote Annex software release required by the Remote Annex Server Tools for Windows NT.

Windows NT Log On Privileges

If you install Remote Annex Server Tools for Windows NT on a primary domain controller, all users must have the right to log on locally. The system cannot authenticate users who do not have this right.
To allow users to log on to the primary domain controller:

1. **Choose** Policies > User Rights.
   
The User Rights Policy window appears.

2. **Select** Log on locally **from the Right field**.
   
The Grant To box displays the names of all groups currently allowed to log on locally.

3. **Edit the list using** [Add] and [Remove].
   
   - To add groups or individual users, click on [Add] and select individual or group names from the Add Users and Groups window.
   
   - To delete users or groups, highlight a name and click on [Remove].

Software Installation

**Server Software**

Installing Remote Annex Network Software for Windows NT loads:

- Operating images that are downloaded to the Annex
- na utilities for configuring and managing the Annex
- Quick2Config Annex for configuring Annex ports

The na utility and the Quick2Config Annex can also be installed on other Windows platforms on the network.
To install Remote Annex software on the server:

1. Put the CD-ROM into the Windows NT server’s CD drive.
2. Use the File Manager to select the CD-ROM disk.
4. Once the setup program runs, the Welcome window appears. Click Next to continue the installation process.

Refer to the Installing Remote Annex Network Software for Windows for installation details.

Workstation Software

Remote Annex software can be installed on other Windows platforms on the Windows NT network:

- The na and Quick2Config Annex software can be loaded on Windows NT Workstations (3.51 or 4.0) and on Windows 95 platforms.
- Quick2Config Annex can be installed on Windows for Workgroups 3.11 and Windows 3.1 systems.

To install Quick2Config Annex on a Windows platform:

1. Put the CD-ROM into the Windows NT server’s CD drive.
2. Use the File Manager to select the CD-ROM disk.
4. Follow the dialog box instructions to select Install Software and then Quick2Config Annex.
5. When prompted for an installation directory, accept the default directory for each software module.
Refer to *Installing Remote Annex Network Software for Windows* for information about installing the na and Quick2Config Annex software on Windows platforms.

If you are installing Quick2Config on a Windows 3.1 or Windows for Workgroups 3.11 platform, you may be required to install additional software that is provided on the CD-ROM. See *Installing Remote Annex Network Software for Windows* for details.

**Hardware Setup**

To set up the Remote Annex hardware:

1. Connect the power and connect the Remote Annex to the network. If you are setting up a Remote Annex 6300, connect CSU (DTE) to the Remote Annex and connect CSU (Net) to the PRI Line.

2. Connect the console cable and terminal.

   The Remote Annex 4000, 6100, and 6300 have a dedicated console port.

   The Remote Annex 2000 uses port 1 as its console port.

   The Remote Annex 539x uses the service port on the 5000 chassis as the console port.

3. Set the terminal to 9600 bps, 8 bits, 1 stop bit, no parity and no flow control.

4. For the Remote Annex 2000 or Remote Annex 4000, turn on the unit and immediately press the `Test` button on the front panel. Make sure the Test LED comes on.


5. If the LED next to the `Test` button is not lit, press `Test` again.
Network Address

After the Remote Annex runs a series of hardware diagnostics, the terminal displays the monitor prompt. Enter address information (step 1) and, if you purchased a LAT key, the LAT key value (step 2).

Step 1 procedures are slightly different for the Remote Annex 6300.

For illustration purposes, sample response values indicate a Remote Annex on an Ethernet network with the IP address 192.9.200.62. The host system address is 192.9.200.55.

1. Enter **addr** and answer the prompts as shown in the example. To accept the default shown in brackets, press the **Return** key.

```
monitor:: addr
Enter Internet address [<invalid or uninitialized>]:: 192.9.200.62
Enter Subnet mask [255.255.255.0]:
Enter preferred load host Internet address [<any host>]:: 192.9.200.55
Preferred load host address: 192.9.200.55
Enter Broadcast address [0.0.0.0]:
Preferred dump address [0.0.0.0]:
Select type of IP packet encapsulation (ieee802/ethereum) [<ether]
Type of IP packet encapsulation: <ether>
monitor::
Load Broadcast y/n [y]:
```

Remote Annex 2000
Remote Annex 4000
Remote Annex 5390
Remote Annex 5391
Remote Annex 6100
Remote Annex 6300  
Remote Annex 5393

1. **Enter addr and answer the prompts as shown in the example. To accept the default shown in brackets, press the `Return` key.**

   ```
   monitor:: addr
   Enter Internet address (hex) <uninitialized>:: 192.9.200.62
   Enter Subnet mask [255.0.0.0]::
   Enter Broadcast address [0.0.0.0]::
   Enter Preferred Load Host address [<any host>]:: 192.9.200.55
   Enter Preferred Dump Host address [0.0.0.0]::
   Enter Preferred Load/Dump Gateway address <uninitialized>::
   Select type of IP packet encapsulation (ieee802/ethernet) [ethernet]::
   Load Broadcast y/n [y]::
   ```

All Annexes

2. **If you have purchased a LAT key, enter the software key provided by Bay Networks.**

   ```
   monitor:: lat
   Enter LAT KEY: [uninitialized]::
   ```

### Booting the Remote Annex

At the Remote Annex, enter `boot` at the monitor prompt:

```
monitor:: boot
Enter boot file name [oper.46.enet]::
Requesting boot file "oper.46.enet".
Unanswered requests shown as "?", transmission errors as "*".
Requesting boot from 192.9.200.55 via Ethernet...
Booting from 192.9.200.55
Header received OK. Received data blocks shown as "."
...EOF
```

The boot file requested in the example is for a Remote Annex 4000 or 6100. Boot files for other models are:

- Remote Annex 2000 oper.56.enet
- Remote Annex 6300 oper.63.enet
Configuring the Remote Annex

Remote Annex 2000
Remote Annex 4000
Remote Annex 5390
Remote Annex 5391
Remote Annex 6100

You can configure Annex ports using either Quick2Config Annex or the na utilities. The following examples apply to non-RA 6300 Annexes that have been installed by using default selections. There is a separate configuration procedure for the Remote Annex 6300 and Remote Annex 5393.

Using Quick2Config Annex

To configure Remote Annex ports using Quick2Config Annex:

1. **Invoke** na, configure the Remote Annex to accept and process SNMP command sets, and exit na.

   `% na
   command: annex 129.9.200.62
   command: set annex allow_snmp_sets y
   command: boot
   command: quit

2. **Click on the Quick2Config icon to open the application.**

3. **Choose** File > Add Annex, enter the name or IP address of the Remote Annex in the dialog box, and click on OK.

   Quick2Config Annex lists the Annex in the tree view on the left and displays a set of tab windows on the right.

4. **Select the Annex and use the tab windows to review and modify Annex parameters.**

5. **Select each Annex port and use the tab windows to configure the port as a terminal or modem port.**

6. **Choose** Help > Contents or click on Help in the dialog box for detailed information on using Quick2Config Annex.

   Refer to the application’s on-line help or to Installing Remote Annex Network Software for Windows for configuration examples.
Using the na Utility

You can also configure Remote Annex ports with the na utilities as shown in the following examples involving non-RA 6300 Annexes installed using default selections.

Modems

Annex supports inbound, outbound and inbound/outbound modems. When entering port speed, set the highest speed supported by the modem. Do not select autobaud.

Set the port parameters using na:

% na
command: annex 192.9.200.62
command: port 6
command: set port speed 115200
command: set port control_lines modem_control
command: set port input_flow_control start/stop
command: set port output_flow_control start/stop
command: set port type dial_in

Inbound Modem
command: set port mode auto_detect

Outbound Modem
command: set port mode slave

Inbound/Outbound
command: set port mode auto_adapt
command: reset port 6
command: quit
Serial Printer

Serial printers can be connected to any Annex serial port. In this example the printer is connected to port 12. Print instructions use the address L12.

Set the port parameters using na and send data to the printer using aprint:

```
% na
command: annex 192.9.200.62
command: port 12
command: set port speed 19200
command: set port type hardwired
command: set port mode slave
command: reset port 12
command: quit
% aprint -A 192.9.200.62 -L12 [filename]
```

Parallel Printer

The Annex parallel ports are configured for a Centronics interface, but can be set for other standards (port 2 in the examples).

**Centronics Interface**

Send data to the printer using aprint:

```
% aprint -A 192.9.200.62 -p1 [filename]
```

**Dataproducts Interface**

Set the printer type using na and send data to the printer using aprint:

```
% na
command: annex 192.9.200.62
command: printer 2
command: set printer type dataproducts
command: reset printer
command: quit
% aprint -A 192.9.200.62 -p2 [filename]
```
Configuring Security

By default, the Annex allows unrestricted access. If you want to configure Annex security, refer to the Remote Annex Server Tools for Windows NT® User Guide.

If you have requested dial-up addresses from the acp_dialup file, refer to the Remote Annex Administrator’s Guide for UNIX for information on adding users to that file.

Check the Security tab and other Quick2Config tab windows to make sure the selections are appropriate to the configured security regime.

Configuring the Remote Annex 6300

Configuration of a Remote Annex 6300 to handle dial-calls from ISDN and analog modems involves using both na and Quick2Config Annex.

Initial Setup with na

Before you configure the Remote Annex 6300 with Quick2Config Annex:

1. Obtain the following information from the telephone company:
   - Switch type
   - Facilities Data Link (FDL) format (ANSI or ATT)
   - Your phone numbers

   Separate phone numbers are required for V.120 and PPP calls. Asynchronous (voice) calls can be distinguished on either phone number.
2. Modify the following parameters in the external CSU through its front panel:

- FORMAT (FDL) = ANSI (or ATT)
- CLOCK = SLAVE
- DISTANCE = 133 ft.

3. Use `na` to enable SNMP sets, modify the PRI parameter `switch_type` if it is other than 5ess (NI-2 or DMS100, for example) and to specify the distance between the Remote Annex 6300 and the CSU.

```
% na
command: annex 129.9.200.62
command: set annex allow snmp sets y
command: set pri switch_type dms
command: set pri dsxl_line_length 101-135
command: boot
command: quit
```

**Setting Up PRI Channels**

To configure PRI channels using Quick2Config Annex:

1. Click on the Quick2Config icon to open the application.

2. Choose `File > Add Annex`, enter the name or IP address of the Remote Annex in the Add Annex dialog box, and click on `OK`.

   Quick2Config Annex lists the Annex in the tree view on the left side of the window.

3. Click on the Annex in the tree view.

   Quick2Config Annex displays a set of tab windows on the right for configuring the selected Annex.

Quick2Config opens an editor with the default configuration file. The Session Parameter Blocks are listed in the `%pri` section.

```
%pri
begin_session sync
called_no 123-555-1212
bearer data
call_action sync
set mode ppp
end_session

begin_session v120
called_no 123-555-1313
bearer data
call_action v120
set mode auto_detect
end_session

begin_session default
call_action modem
set mode auto_detect
end_session
```

5. Modify the telephone numbers for the Sync PPP and V120 blocks to reflect the numbers used to dial the Annex.

6. Copy and modify blocks for other telephone numbers.

7. Select the Annex and use the Call Defaults tab window to set parameters not specified in the Session Parameter Blocks.

8. Choose Autodetect in the Mode box and enter the Annex address as the Local address in the Dial-up Address box.


Refer to the application’s on-line help or to Installing Remote Annex Network Software for Windows for configuration examples.
Configuring Security

By default, the Annex allows unrestricted access. If you want to configure Annex security, refer to the Remote Annex Server Tools for Windows NT® User Guide.

If you have requested dial-up addresses from the acp_dialup file, see the Remote Annex 6300 Supplement to the Remote Annex Administrator’s Guide for UNIX for information on adding users to that file.

Check the Security tab and other Quick2Config tab windows to make sure the selections are appropriate to the configured security regime.